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Tutorial 1: Getting Started
Tutorial 1
Getting started

 

Learning goals

Getting familiar with Quaestor interface.
Adding parameters, relations and constraints.
Providing references and properties for parameters.
Creating a multiple case solution.

Prior knowledge

Interface

1    Objective
As mentioned earlier these tutorials are focussing on providing the basic skills of  . In this first tutorial, the main dimensions of a knowledge engineering
ship will be systematically varied. The knowledge used is Archimedes’ Law in combination with design requirements, which are the following:

The ship should have

a displacement of at least 2000 t, but less than 3000 t;
a draft of 6 m.

Our objective is to generate a dataset of systematically varied ships that meet the design requirements.

2    Before you start
Before starting with your knowledge engineering, please make sure you are actually using the knowledge engineering user level and you have Quaestor
 configured in the most convenient layout.

To check/change your user level go to . You can change your User level. If you are not able to change it to Knowledge Tools -> Options -> General
Engineer (level 3), you do not have   rights. Please contact your ICT department or Qnowledge for the proper license.KE

3    Creating parameters
When Quaestor is started, you are presented with the opening screen, with no knowledge base or project loaded:

https://mods.marin.nl/pages/viewpage.action?pageId=3146743
https://mods.marin.nl/display/QUAESTOR/Knowledge+Engineer
https://mods.marin.nl/display/QUAESTOR/Knowledge+Engineer
https://mods.marin.nl/display/QUAESTOR/User+levels+and+rights
https://mods.marin.nl/display/QUAESTOR/Knowledge+Engineer
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To create your first knowledge base

Select  or click on the leftmost button in the toolbar. File -> New -> Knowledge base

The screen changes to the main Quaestor knowledge engineering screen:
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When a knowledgebase node is expanded, like  here, the  within the knowledgebase are visible. Classes are used to organise your Newqkb classes 
data and equations, and put them in a practicable structure. In Quaestor, all data is put in . You can designate one (or more) parameter as parameters
the goal of the calculation.

The  class is part of the knowledge base by default. Here, the goal parameters of your calculation (Top Goals) can be stored, as Top Goals/Undefined 
well as other parameters that don't belong to other classes (Undefined).

Create a new class, named  , in which the following ship parameters are to be stored.Main Dimensions

Lpp: Length between perpendiculars
: Moulded breadthB
: Draught from keel to Construction Water LineT

Right-click on  and select  from the popup menu. Give the class the name  .Top Goals/Undefined New Class Main Dimensions

Sub classes can be defined by right clicking on any class name and again selecting .New Class

The class is now shown in the knowledgebase tree, and you can add the parameters ,  and . Lpp B T

Classes are a means for organizing parameters for the user. They are not to be  with a class in object oriented computer confused
programming. The Quaestor core does not use the classes at all.It only uses the parameters!
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Select the class   from the main menu. Alternatively, click in the right  and select Main Dimensions Knowledge -> New parameter/function
part of the  , and select  ( ). Give the parameter the name   and click the   button knowledge browser New Parameter / Function Ctrl+I Lpp   Value
to select its type. Repeat these actions for the parameters  and .B T

The added parameters now appear in the right part of the Knowledge browser like this:

A red cross draws your attention to the fact that a parameter is not yet fully defined for the system to use it.

The first requirement is already satisfied, so let's assign dimensions to the parameters.

Select the   row in the  . In the ,  and change the   into , Lpp Knowledge Browser Window Properties window scroll down to the Dimension row ? m
the dimension for  (meters).Lpp

You can also add a  for a parameter. A proper reference is important, as users of the knowledgebase may not be certain of the exact reference
meaning of the parameter. Please also read   for more details.Documentation of knowledge

Scroll down to the  row and enter "length of ship".Reference

https://mods.marin.nl/display/QUAESTOR/Knowledge+Browser
https://mods.marin.nl/display/QUAESTOR/Properties
https://mods.marin.nl/display/QUAESTOR/Documentation+of+knowledge
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Assign a dimension and a reference to the other parameters  and , just as described above. Of course, the breadth and depth of the ship B T
are defined in meters.

Now only the last requirement for valid parameters has yet to be fulfilled: a way to be determined (input from the user or defined by a relation). This 
qualification can be provided in the .Properties window

Select the parameter  . In the Properties window, scroll down to the  row. Change the value to  , as the Lpp Determined by  VR: User only
parameter Lpp is input (instead of defined by a relation).

Notice that now, the status of the Lpp parameter has changed to

to show that Quaestor knows enough about this parameter to use it in a computational model. Now make sure that B and T are determined by   VR: User
 too. By the way, VR stands for .only Value Requested

Note that above you have explicitly added ,  and  as parameters to the knowledge base. You are also able to implicitly add parameters by Lpp B T
creating relations that contain new parameters. Quaestor will automatically add these new parameters to your knowledge base (so, implicitly). You will 
encounter this in the following section.

Save your knowledge base with the name , by selecting .Tutorial 1 File -> Save as

4    Creating relations
In order to define the loading capacity of the ship, it’s important to know the kind of water (Salt or Fresh) the ship will sail in. Therefore, you're going to 
add some  and  , and make sure the user can select the watertype. Two relations must be added, one for salt water and one for relations constraints
fresh water.

Select   in the knowledge browser, right click in the right hand part of the window and select  ( . In the Top Goals/Undefined  New Relation Ctrl+N)
upper part of the new window, delete any proposal (Quaestor may have filled in the last selected parameter), and enter

Rho = 1025

(belonging to salt water), and click Save:

If a parameter still shows a red cross when you have provided all needed property values, click on , and you will see Top Goals/Undefined
the blue cross.

https://mods.marin.nl/display/QUAESTOR/Properties
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Note that when you enter a relation, Quaestor provides as much help as possible by means of the  . This checker shows what to expect Help Checker
(in this case a Value or an Expression,  ). After saving a relation, the Help Checker will check the syntax for possible errors, and shows a ValExp
warning message when something is wrong.

Because of entering the relation, the parameter  has automatically been created. For  to be a valid parameter, a dimension should be assigned.Rho Rho

Provide a reference for  and assign it the dimension  .  is now a valid parameter. Furthermore, make sure  is determined Rho kg/m^3 Rho Rho
by  , as a relation is used to determine .ystem/EquationSYS: S Rho

What follows now might seem a bit unconventional: a second relation is given for Rho. This is a nice example of how Quaestor works: in a 
calculation, Quaestor can find numerous calculation paths and automatically chooses the most appropiate one, based on constraints and available data.

Add the following relation (belonging to fresh water) in a similar way as described above:

Rho = 998

5    Creating constraints
The two relations for the density of the water are only valid for their corresponding watertype. Therefore, a  is added to each relation. A constraint 
constraint is simply a restriction for the validity of the relation.

Click   in the Knowledge browser: all relations in that class are shown (this will work for any class). One can always edit a relation Top Goals/Undefined
by selecting it and pressing  (or right click and select ). This is also a useful method to find out which relation you actually selected.F2  Edit

Right click on the relation   in the Knowledge browser and select  In the upper part of the new window Rho = 1025 Constraint -> Add New. 
enter the following constraint:

Watertype$ = "SW"

The parameter is automatically created in the Class in focus when saving the relation!

An infinite number of relations can be assigned to one particular parameter.

https://mods.marin.nl/display/QUAESTOR/ValExp
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and click :Save

The constraint is now added, and a parameter named  has been created. The  at the end of the parameter name makes Watertype$ $
sure Quaestor recognizes it as a  value, and the dimension  is automatically assigned (see also  ). You have to assign a String  Str  Quaestor syntax Deter

 value to make it a valid parameter.mined-by

Make sure  is determined by  , as the user should provide the information concerning the water type.Watertype$ VR: User Only

Repeat the process for the other relation.

Add the constraint

Watertype$ = "FW"

to the relation  .Rho = 998

Note that the expression editor assists you with the presentation of existing parameters and  s. intrinsic function

Both relations are now connected to the corresponding watertype by means of the value of .Watertype$

Whenever  is needed in the calculation process, Quaestor will note that the watertype is needed to determine the value of , and will ask the Rho Rho
user for this value (because it is assigned to be ).User only

When you select a parameter in the upper list, the relations of that particular parameter are visible:

https://mods.marin.nl/display/QUAESTOR/General+Quaestor+syntax
https://mods.marin.nl/display/QUAESTOR/Intrinsic+functions
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Moreover, when you select a relation in the lower list, the constraints for this relationship are shown:

6    Creating a dropdown menu
Because there are only two possible values for  (SW or FW), it's easy to integrate a dropdown box. Watertype$

 Select  in the Knowledge Browser, select the  tab in the window and in the  box enter the Watertype$ Parameter Properties Reference
following lines:

FW<EQ>Fresh Water

SW<EQ>Salt Water
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The use of a dropdown box will be clear in a later stage of this tutorial, when calculations are made. Note that you can add the   attribute @EQEXPLAIN
in the  box ('data slot') of the  parameter in order to display only "Salt Water" and "Fresh Water" are shown in the dropbox (so without Data Watertype$
SW and FW).

7    Creating a relation for the displacement
On the basis of the earlier defined parameters and the block coefficient Cb , the displacement of the ship can be calculated.

 Add the following relation to the class  :Main Dimensions

DISP = Cb * Lpp * B * T * Rho / 1000

which defines the displacement of the ship in tons.

Note that two new parameters are created: the block coefficient   and the displacement   In order to keep the knowledgebase meaningful, it is Cb DISP.
necessary to provide references, dimensions and determined-by values for these parameters.

Provide references, dimensions and determined by values for  and .  has no dimension (-),  should be in tons (t). Just press Cb DISP Cb DISP OK
if Quaestor warns that tons is no base dimension (kg), it is just to inform you. We covered this by dividing  by 1000. The determined-by DISP
values should be   for , and   for , as the block coefficient is input and the displacement is VR: VR User Only Cb : SYS System/Equation DISP
determined by a relation. Verify that all parameters now have a blue cross instead of a red one in front of them:

8    Creating a solution
Let's perform your first Quaestor calculation. A solution is always determined by one or more Top Goals. A top goal is a parameter (or object) that is 
your final calculation target, in this tutorial it's the displacement of the ship.

https://mods.marin.nl/display/QUAESTOR/@EQEXPLAIN
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 Select the class   in the Knowledge browser. Double click the parameter  .Main Dimensions DISP

Note that the cross in front of  changed to , indicating that it's a top goal for the calculation.DISP

Calculations and solutions are managed in the  . Here, solutions can be created, redone (with different data), examined and deleted. Workbase

In the Workbase window, click the  button to start the calculation with top goal  .Compute Goal(s) DISP

The calculation progress is started, and Quaestor first wants to collect all input data in the Workbase window:

Entering data is easy: just type a value for each selected parameter and press enter to switch to the next one.

Enter the following data for our first calculation:

B = 10   Cb = 0.55   Lpp = 60   T = 6  Watertype$ = SW (Salt Water)   

Note that the input of  consists of a dropdownbox, which you created above:Watertype$

After providing the data you have to press the  button to continue. The actual calculation is started now and because this is a very simple example, Next
the final state is almost immediately shown:

The top goal ( ) is shown, together with all parameters that were used for the calculation. With these input values, the displacement of the ship is DISP
about 2030 tons.

9    Multiple case solutions
So far, you created one solution, which is shown in the workbase:
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As mentioned in the objective, you will create a dataset of systematically varied ships. You could of course perform several calculations with different 
input data by hand, but it's much easier to use the ability of Quaestor to create  . To keep the complexity of this example within multiple case solutions
reason, you will only vary the breadth and length of the vessel. Please note that Quaestor can only perform calculations on ranges of parameters when 
you already have created a solution.

 

In the workbase, select the solution you have already created (called the same as the top-goal parameter  ). Restart the solution by DISP
clicking the  or  button in the workbase, whichever you see.Restart Process Data Input

Change the following input:

B= 9(0.5)11    Lpp= 55(2)69

In this way,  and  are defined by a range, given the start value, step size and end value. For example,  is defined from 55 to 69 meter, with B Lpp Lpp
steps of 2 meter.

Quaestor will ask if it should create a case matrix for  (figure 15), click  (an explanation will follow).Lpp Yes

You will see that the single value input is still in the list and the multi case values are in the table part of the  . Press the  button to Workbase Next
continue.

The new solution is now created. The fixed values are again shown in the right hand side of the workbase. The varying parameters (  and ) and the B Lpp
corresponding solution for are shown in the lower part. Each row is a different  , identified by a  (#1, #2, etc.).DISP case case number

https://mods.marin.nl/display/QUAESTOR/Workbase


Copyright © 2022, MARIN Page 12 of 13

What does the Case matrix question mean?  Note that the variations of  do not correspond to the variations of : there are 5 values for  and 8 B Lpp B
values for . If you would have answered   to the Case matrix question, five variations of B would have been made, each one with the Lpp No
corresponding value of Lpp (the last 3 Lpp values would be omitted). In that way, there would be only five cases. As you answered   to the question, Yes
all possible combinations are considered, which results in 5*8=40 cases. You can easily notice the difference by creating a new solution with the same 
input values, but now answer no to the case matrix question.

10    Filter results

As it is, the multiple case solution table is sorted by the breadth of the ship. Now suppose you'd like parameter Lpp to be the leading parameter in this 
table.

 In the knowledge browser, select the parameter  . In the  window, scroll down to the row  , and select  . Now, Lpp Properties Output to HEADER
refresh the table of the multiple case solution by clicking another solution, and then again the multiple case solution. The table is now headed 
by .Lpp

A lot of cases in your solution don't meet the design criteria: a displacement between 2000 and 3000 ton. We could have fixed this by adding a 
constraint to , but another way is to use a  in the solution table.DISP filter 

In the workbase, select the last (multiple case)  solution, and click the  button. The Filter window shows. For , select   as DISP Filter DISP Range
filter, fill in   for   and   for  . Click the   button.2000 Lower bound 3000 upper bound Apply

Ranges can be defined in multiple ways: 

Individual values can be separated by comma’s: 9, 10, 11 or by semicolons. This depends on the setting of Tools->Options-
.>Modeler->Use ; instead of , in range input

You can define a range with a begin, an end and number of steps (intervals): 9(&2)11
You can define a range with a begin, an end and a step size: 9(1)11
You can define a range with a begin, an end and a step size, including the last element when this is smaller than the whole amount 
of steps: 9(#1)11.5
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Now, only the cases for which 2000 <  < 3000 are shown in the table. The objective of this tutorial is now completed: you built a dataset of DISP
systematically varied ships that meet the design criteria.

11    Check
You can verify your results by comparing it to  [Tutorial 1 Finished] .

Continue to tutorial 2 >>

 

https://mods.marin.nl/download/attachments/3163159/Tutorial1Finished.qkb3?version=1&modificationDate=1402500111000&api=v2
https://mods.marin.nl/display/QUAESTOR/Tutorial+2%3A+Objects+and+TeLiTabs
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